f you've used Photoshop for any length of time, you’ve no doubt used

layers; they’re such a key feature of the software. In fact, if you're doing

anything other than simple photo retouching, layers are pretty much
essential.

The beauty of layers is that you can work on different parts of your image
independently; if you draw on one layer, the other layers in your image
remain untouched. This means you can easily try out different ideas (and
easily scrap them if you don't like them!).

Layers offer you a great deal of flexibility when it comes to creating your
images. If you don't like the position of a logo, for example, simply drag it to
anew position —if it’s on its own layer, then it'll move on its own, without
disturbing the rest of the image.

You can also use layers artistically. For example, layer blending modes give
you a wealth of composition tricks that you can use to really make your
images come to life, while adjustment layers allow you to make tonal adjust-
ments to your images without altering the underlying pixels.
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F Learn more about layer blending modes in Chapter 7.

In this chapter, you look at the history of layers in Photoshop and explore
key concepts such as the Layers palette and transparency. Each of the basic
layer types is explained, and some of the uses and applications of layers are
discussed. Finally, we finish off with a simple example to help cement the
concepts that are introduced.
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Understanding the Layers Concept

A good way to understand the concept of layers is to think of them as physical sheets of acetate
laid on top of each other (see Figure 1.1). You can add, copy, and delete layers; you can hide them,
and move them around horizontally and vertically in the image; and you can also move layers up
and down the stack to change their order. When you change something on one layer, you only
affect that layer.

FIGURE 1.1

Layers are like sheets of acetate— each layer is independent of the others.

Layers and Photoshop

Before layers were introduced in version 3 of Photoshop, every change you made to your image
was effectively applied to a single layer. You can imagine how difficult this made things for
Photoshop designers! All changes were pretty much permanent. Photoshop didn’t even have a
History palette then, so you only had one undo level. Understandably, folks using Photoshop 2 and
earlier used to make a lot of backup copies of their Photoshop files!
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Now you have a variety of layer types to choose from and a range of powerful layer editing fea-
tures. Its hard to imagine working in Photoshop without using layers; they really have become a
central part of the software.

Most of the time, when you work on an image in Photoshop you're working on a single layer at a
time. For example, most of the filters, the image adjustment functions under Image =

Adjustments, and the standard cut and copy commands (Edit & Cut and Edit &> Copy) all work
on the current layer only.

"N

Introducing the Layers Palette

I Some tools, such as the Type tools and the Shape tools (by default at least), also create
% new layers when you use them.

Most of the layer-based action in Photoshop hinges around the Layers palette, as shown in Figure
1.2, so take a quick look at its features. If this palette is not currently visible, you can enable it by

choosing Window => Layers or pressing F7.

FIGURE 1.2

The Layers palette in Photoshop
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The Layers palette usually shows at least one currently selected layer (called the active layer).
Photoshop also gives each layer a name to help you identify it more easily. The name of the active
layer is always shown in bold text in the Layers palette, and the layer itself is shaded a different
color to the other layers in the palette. The active layer’s name is also shown in the title bar of the
document window, which is handy for those times when your Layers palette is buried under ten
document windows and seven other palettes.

The Layers palette includes the following controls to help you work with layers:

B Blending Mode: This pop-up menu lets you control how the active layer blends with the
layers below it. For more information, refer to Chapter 7.

B Lock options: These four buttons allow you to lock various aspects of a layer — its trans-
parency pixels, its image pixels, its position, or all three. For more information, see
Chapter 2.

B Opacity and Fill controls: These options let you specify how much of the image under-
neath the active layer shows through. For more on these controls, see Chapter 2.

B Link Layers icon: Use this icon to link two or more layers together so that they can be
manipulated as one layer. See Chapter 2 for more details.

B Add a Layer Style icon: As its name suggests, this icon lets you add styles to layers.
Layer styles allow you to add effects such as drop shadows and beveling. Layer styles are
covered in detail in Chapter 10.

B Add Layer Mask icon: Use this icon to create a layer mask for the current layer. See
Chapter 9 for more on layer masks.

B Create New Fill or Adjustment Layer icon: You can use this icon to quickly create
either a fill layer (for adding a solid color, gradient or pattern fill effect to your image) or
an adjustment layer (for applying adjustments to other layers in your document). Chapter
6 explores these layer types.

B Create a New Group icon: This icon allows you to group your layers together. For more
on this topic, see Chapter 2.

B Create a New Layer icon: This is for creating a new, empty layer in your document.
Learn about the different ways you can make new layers in Chapter 2.

B Delete Layer icon: Use this icon to remove unwanted layers from your document. This
and other ways to delete layers are covered in Chapter 2.

You can resize the Layers palette (like all palettes in Photoshop) by clicking and drag-

e : ging the resize box in the bottom right-hand corner of the palette. A small palette is
great if you lack screen real estate, and a big palette is handy when you need to look at a lot of layers
at once. If the palette really gets in the way, you can minimize it by double-clicking the Layers tab at
the top of the palette, or by clicking the little minimize icon to the left of the Close button at the top
right of the palette. Double-click the tab again, or click the icon again, to reopen the palette.
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Layers in the document window

The contents of all visible layers in a document are displayed in the document window. Each layer
in your document appears in the palette in the order in which it is stacked in the document, so the
foremost layer is always at the top of the list and the background layer is at the bottom. Figure 1.3
shows how layers in the Layers palette relate to their contents in the document window.

The Layers palette shows the layers for the currently selected document. If you have several docu-
ments open at once, you see the Layers palette change as you flip between the document windows.

FIGURE 1.3

How layers appear in the Layers palette and in the document window
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The anatomy of a layer

Although there are many different types of layers in Photoshop, all layers share the following fea-
tures (see Figure 1.4):

B Eye icon: This indicates whether the layer is visible in the document or not. Click the eye
icon to hide the layer; click it again to show the layer.

B Thumbnail: The thumbnail image shows you a small preview of the layer. It also shows
you which parts of the layer are transparent, indicated by a grid of white and gray (by
default) squares.

B Layer name: This helps you identify the layer. You can easily change a layer’s name by
double-clicking it, then typing the new name. (By the way, if you double-click the layer
outside the layer name, the Layer Style dialog box appears, allowing you to create layer
styles such as drop shadows. Layer styles are covered in Chapter 10.)



B Lock icon: This icon shows you whether the layer is unlocked (no icon), partially locked
(light lock icon), or fully locked (dark lock icon).

FIGURE 1.4

Each layer always has an eye icon (hidden if the layer is invisible), a thumbnail, a name,
and, potentially, a lock icon.
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You can customize the look of the layer thumbnails by clicking the triangle in the top-
right corner of the Layers palette and then choosing Palette Options from the pop-up
menu. You can choose from three thumbnail sizes (or no thumbnails at all) and also specify whether
you'd like each thumbnail to show just the contents of the layer (Layer Bounds) or show the position
of the layer in the whole document (Entire Document). You can also reach these options by right-
clicking any layer thumbnail in the Layers palette.

Understanding Layer Transparency

Just like sheets of acetate, layers in Photoshop are inherently transparent. This means that the parts
of a layer that haven't been painted on allow the pixels from the layers underneath to show
through. You can also make a whole layer semitransparent by adjusting its Opacity slider (see
Chapter 2 for more on layer opacity).

The exception to the transparency rule (there’s always an exception) is the special

St Background layer, which can’t be made transparent at all. As the name implies, it’s
always at the back of the document — nothing can get behind it —so it has no need of transparency.
More on this maverick layer in the section “The Background layer.”

Each pixel in a layer can be completely transparent, completely filled with color, or translucent
(somewhere in between). This is all controlled by a transparency mask associated with each layer.
The transparency mask determines how transparent or opaque each pixel in the layer is.

You can load a layer’s transparency mask as a selection by Ctrl+clicking (88+clicking on
is WSS the Mac) the layer’s thumbnail in the Layers palette, or by right-clicking the thumbnail
and choosmg Select Pixels from the pop-up menu.

You can see the transparent areas of a layer by looking at its thumbnail image in the Layers palette —
the transparent parts are shown as a gray and white checkerboard pattern. Also, try Alt+clicking
(Option+clicking on the Mac) the eye icon of a layer in the Layers palette to hide all other layers; if
your layer has any transparent parts you see them as a checkerboard pattern in the document win-
dow, as shown in Figure 1.5. (Alt/Option+click the layers eye icon again to return to normal.)
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FIGURE 1.5

A layer on its own in the document window, showing the transparency grid behind
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If you find the default checkerboard pattern hard to see in a particular situation —
working with a photo of a chess board springs to mind — you can change its color and
size. To do this, choose Edit > Preferences = Transparency & Gamut (Photoshop => Preferences =
Transparency & Gamut on the Mac) or, more quickly, press Ctrl+K then Ctrl+6 (88+K then 8+6 on
the Mac). You can then choose a grid size (or turn the grid off altogether) and choose from a prede-
fined list of grid colors (or roll your own).

Many functions in Photoshop just work on the nontransparent areas of a layer and leave the trans-
parent areas intact. Other tools, such as the painting tools for example, will, of course, paint over
the transparent areas (unless you have the layer transparency locked). If you want to make part of
your layer transparent again, paint on it with the Eraser tool, or select the part you want to make
transparent and press Backspace (Delete on the Mac).

To fill a layer entirely with the foreground color, press Alt+Backspace (Option+Delete

i on the Mac). Want to fill with the background color instead? Just press Ctrl+Backspace
(88+Delete on the Mac). To fill just the opaque and translucent areas, leaving the transparent areas
intact, either lock the layer’s transparency first, or use the previous keyboard shortcuts with the Shift
key as well. This is a super-quick way to recolor an object on a layer.

Types of Layers

Photoshop features a few different types of layers and, although all the layer types share common
ground, there are important differences among them. Let’s take a brief look at the different mem-
bers of Photoshop’s layers family.




The Background layer

Images created with a white or colored background are created with a special layer called
Background (see Figure 1.6). There cannot be more than one Background layer in a document.
The Background layer is always at the back of the document (and therefore the bottom of the
Layers palette), and it never has any transparent areas. You can’t move this layer up and down the
Layers palette, nor can you move its contents around with the Move tool, or change its blending
mode or opacity, which are permanently locked.

However, you can delete the Background layer, which makes your document transparent.
Likewise, you can create a new transparent document, which has no Background layer. You can
also hide the Background layer to make your document temporarily transparent.

See Chapter 2 for more on showing and hiding layers and groups.
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By now you're probably wondering what the point of the Background layer is, as it just seems to be
a normal layer with its hands tied behind its back. In fact, its limitations are really its strengths:
Because it’s always at the back of your document and can’t be made transparent, you can always
rely on it as a canvas or backstop, if you will. Without a Background layer you can never be totally
sure that some bits of your document aren'’t transparent (although you’d find out soon enough if
you later tried overlaying your image on top of something else).

If you choose File = Open to open an image that’s in a format that doesn’t support
layers — for example a JPEG photo — then Photoshop automatically assigns the image to
the Background layer in the opened document.

FIGURE 1.6

The Background layer. As its name implies, this special layer always sits in the background of your image
document.
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Generally, you want a Background layer in your document unless you need the document to be
transparent — for example, if you print it out onto transparencies, or you're saving out a transpar-
ent GIF for use on the Web.

¥ You can convert between the Background layer and a normal layer (and vice versa).
% Find out how to do this in Chapter 2.

Normal layers

The most common layers you encounter in Photoshop are normal layers (see Figure 1.7). The basic
job of these layers is to hold the various bitmapped images that make up your document. The
Background layer described previously is essentially a normal layer that’s locked down to the back
of the document.

10
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FIGURE 1.7

A normal layer. To create a new normal layer, simply click the New Layer icon.
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To create a new normal layer, click the New Layer icon at the bottom of the Layers palette, as
shown in Figure 1.7.

Type layers

As you might imagine, type layers (see Figure 1.8) are used specifically for storing type — other-
wise known as text. They were a godsend when first introduced in Photoshop 5, as they allow you
to edit, scale, rotate, and generally muck about with your type after you create the layer. The rea-
son they can do this is that they store the type as vector information rather than as bitmapped
images. (Versions of Photoshop before version 5 allowed you to create type, but the type was
stored as a bitmapped image, making transforming or editing after the fact practically impossible.)

FIGURE 1.8

A type layer. To make a new type layer, use the Type tool.
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Comparing Bitmaps and Vectors

bitmapped (or raster) image is an image made up of pixels — for example, a JPEG photo from a

digital camera or a GIF image in a Web page. Bitmapped images are great for storing real-world
images, such as photos, that can’t easily be mathematically defined. The main disadvantages of
bitmapped images are their large file size and the fact that they can’t be scaled well —if you enlarge
a bitmapped image you quickly start seeing aliasing or, to use a technical term, “jaggy bits.”

In contrast, a vector image is defined mathematically using lines and curves. It's not made up of pix-
els like a bitmapped image is. This means that vector images are resolution-independent; it doesn't
matter how big or small you scale a vector image, it never loses detail. Vectors are great for storing
images that are easily described using lines and curves and that need to stay pin sharp at any
resolution — for example, type, logos, geometric shapes, and charts.

To create a new type layer, select the Type tool in the Toolbox as shown in Figure 1.8, click in your
document window, and start typing. Press Ctrl+Enter (8+Return on the Mac) when you finish

typing.

}; symes Type layers and the Type tool are given a thorough treatment in Chapter 4.
Y DTIET

Shape layers

You can create shape layers (see Figure 1.9) using the Pen and Shape tools by enabling the Shape
Layers option in the tool’s options bar. Although they're described as a distinct type of layer in
Photoshop, a shape layer is really just a fill layer in disguise (see the next section) with a linked
vector mask. The fill layer gives the shape its color, gradient, or pattern, and the vector mask gives
the shape its, well, shape. Because vectors are used to describe the shape, shape layers can be
scaled, rotated, and otherwise manipulated with no loss of detail.

To create a new shape layer, select a pen tool or a shape tool, as shown in Figure 1.9, make sure
Shape Layers is selected in the tool’s options bar; then draw in the document window.

! For more on shape layers see Chapter 5.

ROSSREF
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FIGURE 1.9

A shape layer. Create new shape layers using the Pen or Shape tools.
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Fill layers

Fill layers (shown in Figure 1.10) hold a solid color, a gradient, or a pattern. The basic fill always
fills the whole canvas area, so fill layers really come into their own when you use them with a
linked layer mask. By drawing on the mask with, for example, the Brush or Pen tool, you can
define which areas of your document are filled and which are masked off from the fill.

In fact, when you first create a fill layer it comes complete with its own linked (bitmap) layer mask
that you can use to define the shape of your fill. Similarly, when you create a new shape layer (see
the section on shape layers) the created fill layer ships with a linked vector mask defining the shape.

FIGURE 1.10

A fill layer. Click the New Fill or Adjustment Layer icon to create new fill layers.
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To create a new fill layer, click the New Fill or Adjustment Layer icon at the bottom of the Layers
palette (see Figure 1.10) and choose Solid Color, Gradient, or Pattern.

@ Learn about fill layers in Chapter 6.

Adjustment layers

Adjustment layers (shown in Figure 1.11) are fairly unique in that they work by affecting the layers
below them, rather than holding image information themselves. (If you add an adjustment layer to
a document containing no other layers, you won't see anything happen in the document.)

The wonderful thing about adjustment layers is that you can happily adjust aspects of your image
such as levels, color balance, brightness, and contrast without permanently affecting the actual pix-
els of the image. This is often called nondestructive editing.

For example, if you really turn up the brightness of your photo by choosing Image = Adjustments =
Brightness/Contrast, then try lowering the brightness later, you'll see that your image has lost a lot
of contrast — the Brightness/Contrast adjustment has permanently altered the pixels and some of
the image information has been lost. However, if you create a new Brightness/Contrast adjustment
layer, you can happily change the brightness as much as you want at any time without affecting the
underlying image.

This makes adjustment layers great for trying out adjustments that you might want to tweak later on.

FIGURE 1.11

An adjustment layer. Create new adjustment layers with the New Fill or Adjustment Layer icon.
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To create a new adjustment layer, first click the New Fill or Adjustment Layer icon at the bottom of
the Layers palette, as shown in Figure 1.11, and then choose any option apart from Solid Color,
Gradient, or Pattern.

Figure 1.12 shows all the previous layer types in action in a document, with a cute kitten thrown
in for good measure. See if you can guess what the job of each layer is in the document.
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FIGURE 1.12

Different types of layers in action. Notice how the layers stack together and interact with each other to pro-
duce the finished image.
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Using Layers in Photoshop

As you might have gathered by now, layers are an extremely handy feature in Photoshop. Here are
just some of the feats you can achieve with layers:

B You can create as many new layers as you want in your document. The number of layers
in your document is limited only by the memory available to Photoshop. Be careful
though, because each layer adds to the file size of your Photoshop document; if you're
not careful you can end up with very large files. (For more on creating new layers, see
Chapter 2.)

B Select one or more layers in your document, and you can work on just the selected layer
or layers. You can select layers using the Layers palette or directly in the document win-
dow. (To find out more about selecting layers, see Chapter 2.)

B You can make copies of layers, both in the same document and between documents. You
can move the contents of a layer around the document window, either independently or
in tandem with other layers, and you can align or distribute different layers in your docu-
ments. You can change the stacking order of layers in your document; you can lock
aspects of layers to prevent them being accidentally altered; and, of course, you can delete
layers that you no longer need. (To learn any of these techniques, see Chapter 2.)

B If you want, you can link layers together so that they can be manipulated as a single layer.
You can also group layers together to help organize documents with lots of layers; hide
selected layers and groups to try out different designs; and color-code layers and groups
for easy access — great if you have several layers or groups related to a particular part of
your document. (All of these features are described in Chapter 2.)
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B Using blending modes, you can control how a layer blends with the layers below it to cre-
ate all sorts of interesting effects and enhancements. (For more information on blending
modes, see Chapter 7.)

B You can mask off areas of your layer so that only some areas are visible. You can also use
masks with adjustment layers to apply the adjustments to selected parts of your image.
(For more information on masks, see Chapter 9. Adjustment layers are covered in
Chapter 6.)

B A layer can be used to mask the contents of another layer or layers above it, allowing you
to achieve all sorts of creative effects. (For more on this, see Chapter 9.)

B You can add many artistic effects to a layer using layer styles. Even better, you can go
back and tweak these effects at any time without touching the contents of the layer itself.
(For more on layer styles, see Chapter 10.)

B As mentioned previously, adding text to your documents is easy with Photoshop’s Type
tool. This tool creates special type layers that can be edited, transformed, and generally
mucked about with long after they are created. (The Type tool is covered in depth in
Chapter 4.)

B Photoshop lets you take several snapshots of your documentss layers, including their visi-
bility, position and appearance, and flip between them instantly, great for trying out dif-
ferent designs and arrangements of layers. (For more information, see Chapter 11.)

New Layer Features in Photoshop CS3

With the launch of Photoshop CS3, Adobe has added a wealth of useful new features to the mix,
making it a worthy successor to CS2. This section concentrates on the new, flexible user interface
in CS3, as well as the new layer-related features that Adobe has included in CS3.

The new interface

One of the major changes in CS3 is the introduction of a new user interface. Not only does it give
Photoshop a new, revamped look, but it also changes the way you work with the software, thanks
to its new workspace features. Maximized Screen Mode, for example, creates a workspace where
your document window automatically resizes, depending on the layout of the palettes, to fill the
maximum space possible. You can choose this option from the Toolbox using the Change Screen
Mode button at the bottom. Figure 1.13 shows Maximized Screen Mode in action.

As well as grouping palettes together in palette groups, as you could in CS2, you can now also
group palettes and palette groups into bigger docks. These docks can be contracted when they’re
not in use, with the palettes and palette groups inside turning into cute icons, as you can see in
Figure 1.13. Its a handy feature that helps you to maximize your screen real estate.



Introducing Layers _
FIGURE 1.13

The new interface in Maximized Screen Mode, with the palette docks expanded (top) and collapsed to
icons (bottom). Note that the document window you’re working on resizes with the palettes, so that it
always fills the available space.
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FIGURE 1.14

There are also changes to the Toolbox, which can now be presented as a single-column view. This
may give seasoned Photoshop users a twinge of fear, because the new layout can feel a little odd in
comparison to the old style two-column version. Don't panic, though; with a single click on the
small arrows at the top of the Toolbox you can bring back the familiar two-column view. In fact, if
you find you really cant get along with the new interface at all, you can flip over to a legacy version
that mimics the old CS2 interface, by choosing Window = Workspace = Legacy.

Smart Filters

Photoshop CS2 introduced the concept of Smart Objects — special layers that allow you to resize,
rotate, and warp bitmap images nondestructively. In CS3, this functionality is expanded with the
addition of Smart Filters. This feature allows you to add “live” filters to a Smart Object nondestruc-
tively. The Smart Filters also have their own mask, so that you can apply the filters selectively to
the Smart Object.

In practice this means that you can apply a Radial Blur filter to a Smart Object, for example, and
then reedit or remove that blur later on in the process if you change your mind. Figure 1.14 shows
a Smart Object with such a Smart Filter applied. This is a major leap forward for Photoshop and
brings it more into line with the nondestructive tendencies of many major applications in the
graphics world, as well as the audio/visual world. New photo-editing applications such as Adobe’s
Lightroom and Apple’s Aperture, for example, allow for nondestructive editing.

This nondestructive feature of Smart Objects is great for normal bitmap layers: Simply
add your normal layer to a Smart Object, and you can transform the Smart Object over
and over again without progressively degrading the image. However, any transform you make still
results in some loss of quality; for example, scaling a bitmap by 1000 percent is likely to produce a
fairly blocky result, even if it’s within a Smart Object. This is a fundamental issue with bitmaps and is
one reason why vector type and shape layers are an attractive alternative.

r=d Smart Objects and Smart Filters are covered in detail in Chapter 8.

Applying a nondestructive Radial Blur to a Smart Object, using the new Smart Filters feature of
Photoshop CS3
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New adjustment layers

In Photoshop CS3, there are two very welcome new adjustment layers, both aimed squarely at
photographers: Black and White, and Exposure.

The Black and White adjustment layer provides a new way to convert color photos to black and
white. Traditionally this has been a somewhat fraught task involving much voodoo using the
Channel Mixer, or through Lab color conversions. With this adjustment layer, you can also add a
tint to the image at the same time, which is great for those images requiring a sepia tint, for exam-
ple. You can see this adjustment layer in action in Figure 1.15. Note that this adjustment is also
available in destructive form under Image = Adjustments.

In Chapter 15, you see how many of the traditional black-and-white conversion tech-
¥ niques stack up against this great new feature.

FIGURE 1.15

Converting an image to black and white using the new Black and White adjustment layer
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The Exposure adjustment layer, shown in Figure 1.16, allows you to mimic the effect of increasing
the exposure setting in-camera. If you have a woefully underexposed image, there’s a good chance
you can save it using this feature. It really is great for enhancing those slightly lackluster photos.
And of course, because adjustment layers have their own masks, you can choose to increase the
exposure just on selected areas of the image.

While the destructive Exposure adjustment — found under the Image => Adjustments
menu — has existed in previous versions of Photoshop, this is the first time that you've
been able to apply Exposure nondestructively as an adjustment layer.
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Increasing the exposure of a photo with the new Exposure adjustment layer

@ 0O e o

DSC_1257 PG @ 50%

Exposure
Exposure: m @
= ( Cancel )
Offset: W‘ I:: Lo—ad_“ J
Gamma Correction: 1.14 | I;_S“E“' /\'
AP - |
# Preview

Auto-Align Layers and Auto-Blend Layers

Imagine you have two or more images that you want to merge into one. This might be a double
exposure of a landscape, a panorama, or a photo of the same environment with different people in
it, for example. Photoshop CS3 introduces two great new commands — Auto-Align Layers and
Auto-Blend Layers — that can help you enormously with this merging process. These two com-
mands are both available from the Edit menu.

The Auto-Align Layers command, whose dialog box is shown in Figure 1.17, automatically aligns
images on separate layers by subtly distorting each image so that they line up as precisely as possi-
ble. You can then use masks to reveal the elements from each layer that make up the final image.
Because Photoshop is doing the alignment work, a small movement in perspective when taking the
original photos is less important. In other words, if you're stuck without a tripod, its no longer
necessarily the end of the world!

The Auto-Blend Layers command works in conjunction with Auto-Align Layers when creating
panoramic shots. When you apply it to a newly aligned set of layers in a panoramic format, this
feature creates a new layer mask for each layer and applies its best guess for blending the photos to
each mask, softening sharp edges created by auto-aligning the layers. It also compensates for any
exposure differences when the individual photos were shot by changing the colors within each
layer, smoothing out the differences between warmer and cooler images.
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FIGURE 1.17

The Auto-Align Layers dialog box. This command automatically aligns two or more layers by subtly distort-
ing each layer.
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The results for the Auto-align and Auto-blend combination are very good, and are also now inte-
grated into the Photomerge feature used for stitching panoramic shots. In CS2, the results of the
Photomerge feature created layers with no masks, but in CS3 the feature creates individual layers
with masks, resulting in a much faster workflow and more control over the end result.

Both of these new features are explored in depth in Chapter 15.

Putting Theory into Practice

Now that the basics of layers in Photoshop have been covered, we can begin with a practical exam-
ple. In this short tutorial, it is assumed that you're lucky enough to own a yacht and that you want
to invite some friends to sail it with you. You're going to produce a simple invitation, with a photo
of your boat and some text with relevant information.

Obviously, you won’t have this yacht photo yourself. No problem; for the sake of this
S tutorial, any photo will do. Ideally it should be in portrait format and at least A6 size
(4 x 6 inches) at 300 dpi. A photo taken with a modern digital camera should be fine.

21



Creating a new document

The first step to designing your invitation is to create a new Photoshop document. Choose File =
New or press Ctrl+N (38+N on the Mac). The New dialog box appears. You want to create an A6
invitation, which is 105 x 148 mm, at 300 dpi. To do this, choose International Paper for the
Preset option; then choose A6 for the Size option. Make sure Resolution is set to 300 pixels/inch.
Stick with the default RGB color mode for this example. Choose a white background, give the docu-
ment a name, and click OK to create the document, as shown in Figure 1.18.

FIGURE 1.18

Creating the new invitation document
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A document window appears for your new document — it’s the right size and it has a white
Background layer, ready for you to start adding your layers.

Adding the photo

The next step is to open the photo and add it to your invitation. Choose File &> Open, or press
Curl+O (38+0 on the Mac) and choose a suitable photo from your photo library. Your photo opens
in a new document window.

Now, add the photo to the invitation. Make sure the document window containing the photo is
selected and look at the Layers palette (choose Window = Layers or press F7 if you can't see the
palette). You should see a single layer, called Background, with a little thumbnail image of your
photo (see Figure 1.19). This is the layer that contains the photo you just opened.
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FIGURE 1.19

The photo layer in the Layers palette
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You're now going to copy this layer into your invitation document. To do this, click the layer in the
Layers palette, and while holding down the Shift key, drag the layer to the invitation document as

shown in Figure 1.20, and release the mouse button. After a short pause your photo appears in the
invitation document.

I Holding down Shift while dragging the layer automatically centers the photo in the
! invitation document.

FIGURE 1.20

Dragging the photo layer across to the invitation document
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Look at the Layers palette for the invitation document (if the invitation document isn't selected,
select it first), and you see that the photo has been added to the document as a new layer, as shown

in Figure 1.21. You now have two layers in your invitation: the original white Background layer,
and the new photo layer.

Give your photo layer a name so it’s easier to identify. Double-click the name of the layer — this is

probably Layer 1 —and type Yacht (or whatever you want to call your photo); then press Enter
(Return on the Mac).

FIGURE 1.21

The photo in the invitation document and its layer in the Layers palette
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Creating a box for the text

Add a white box to the invitation that you can place the text in. To do this, follow these steps:
1. Select the Yacht layer by clicking it in the Layers palette. This step ensures that your
new box layer is created above the Yacht layer.

2. Click the Shape Tool icon and hold down the mouse button. (The Shape tool icon sits

below the Type Tool icon in the Toolbox.) After a second, a pop-up menu appears, with a
list of different shape tools.

3. Click the Rectangle Tool icon. The Shape tool icon changes to a rectangle.

Click the Default Foreground and Background Colors icon in the Toolbox (or press
D). This resets your foreground and background colors to their defaults of black and
white respectively.
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5. Now click the Switch Foreground and Background Colors icon (or press X). You
should now have a foreground color of white and a background color of black showing in
the Toolbox. The Rectangle tool uses the foreground color as the fill color of the box, so
your box is created with a white fill.

6. Make sure the Shape Layers option is selected in the Options bar.

7. Create the box. Click somewhere near the top-left corner of the invitation document and
drag down and to the right, then release the mouse button to create the box (see
Figure 1.22).

FIGURE 1.22

Creating the white box shape
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Notice that you've created a new shape layer in the document. Click the shape layer’s name in the
Layers palette to edit it, type Box, and press Enter (Return on the Mac).

Adding the text

Now, add some text in the white box. Use a text color taken from the photo. Click the Eyedropper
tool in the Toolbox (or press 1); then click an area of your photo that you want to use for your text
color (see Figure 1.23). In the figure, a blue color is selected from the sky in the photo. The color
of the pixel that you click becomes the new foreground color.

Next, make sure the Box layer is selected by clicking it in the Layers palette. This ensures that the
type layer is created above the Box layer.
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Picking a color from the photo
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| Ensure that the Box layer’s vector mask is not active, or the type will be anchored to the
" vector mask. To do this, look at the vector mask thumbnail for the Box layer (the little
rectangle just to the left of the layer name). If the thumbnail has a highlight border around it, click in
the thumbnail to remove the highlight and deselect the mask.

Click the Type Tool icon in the Toolbox and hold the mouse button down. From the pop-up menu,
select the Horizontal Type Tool option.

Choose an appropriate font and style for your text. In the Type tool’s options bar (see Figure 1.24)
choose a simple sans serif font such as Arial or Helvetica, select a Regular font style, and choose an
appropriate size for the type (18 points or 72 pixels should do it).

B When creating type, you can choose between points and pixels (and millimeters, too) by
% choosing Edit = Preferences > Units & Rulers (Photoshop = Preferences > Units and
Rulers on the Mac) and picking a unit from the Type pop-up menu.

FIGURE 1.24

Choosing type options
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Click in the document window near the top-left corner of your white box and type Come sail
with me!. Press Enter (Return on the Mac) a couple of times to move the cursor down toward the
bottom of the box. Choose a smaller type size in the options bar (for example, 10 points or 48 pix-
els). Type the next line, 23rd April, and press Enter (Return). Repeat for the last two lines, 9am at

The Marina and Bring a coat!.

When you've typed all your text, press Ctrl+Enter (88+Return on the Mac) to exit the text entry

mode.

You now have a fourth layer in your document: a type layer. Photoshop uses the text you typed as
the name of the layer; however, you can change this if you want by double-clicking the layer name,

typing a new name and pressing Enter (Return on the Mac).

Congratulations — you've created your invitation! It probably looks something like Figure 1.25.

FIGURE 1.25

The finished invitation
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Playing with the layers

Your invitation design is made up of four separate layers. From bottom to top in the Layers palette,

they are:

The white Background layer

A normal layer containing your photo

A shape layer containing your white box

A type layer containing the text inside the white box
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Try playing with the different layers. For example, click the Move tool in the Toolbox (or press V),
select one of the layers, then click in the document window and drag with the mouse. Notice how
the layer moves around independently of the other three layers. Notice also how you can’t move
the content of the Background layer.

& If you do ever need to move the content of the Background layer, convert it to a normal
% layer first. Find out how to do this in Chapter 2.

Click a layer in the Layers palette and drag it up or down to a different position in the palette.
Notice how changing the stacking order of the layers in the Layers palette affects how the layers
appear in the document window. For example, if you drag the type layer below the Box layer in the
Layers palette, the type is then obscured by the white box.

Ctrl+click (88+click on the Mac) the type and Box layers to select both of them, then click the Link
Layers icon at the bottom of the Layers palette. The two layers are now linked. Try moving one of
the layers using the Move tool. Notice how the other layer moves with it. To unlink the layers,
select one of the layers in the Layers palette and click the Link Layers icon again.

! Learn all about linking layers in Chapter 2.

Maybe that white box is a bit too big or small? No problem —it’s a shape layer so you can resize is
as much as you want without losing any quality. Select the Box layer in the Layers palette then
choose Edit = Transform, or press Ctrl+T (88+T on the Mac). Click a transform handle at a corner
or edge of the white box in the document window; then drag with the mouse to resize the box.
Press Enter (Return on the Mac) when you’re happy with the new size.

I For more on the wonders of shape layers, see Chapter 5.

This example project gives you a small taste of layers in Photoshop. You've looked at creating nor-
mal layers, shape layers and type layers, learned how layers work together to form the finished
document, and seen how layers can be manipulated independently of each other.

Summary

This chapter introduced you to layers in Photoshop: what they are and why they’re such useful
beasts. You learned how to get around in the Layers palette, and you also learned what layer trans-
parency is and how it works.

The different types of layers available in Photoshop have been touched on, from normal layers
through to type layers, shape layers, adjustment layers, and fill layers, as well as the special
Background layer. You've looked at just a few of the things you can do with layers, and finished
with a simple example to help you get to grips with the concepts that were introduced.

The remaining chapters of this book cover the finer points of working with layers in Photoshop.



